# Table of Contents

1. GENERAL OVERVIEW ......................................................... 3

1.1. Software Installation ..................................................... 4

1.1.1. System Requirements .................................................. 4

1.1.2. Install Process ......................................................... 4

1.2. Running Program ......................................................... 12

1.2.1. Terminal IP Setting ................................................... 13

1.2.2. PC IP Setting .......................................................... 15

1.2.3. Connect & Disconnect ................................................ 17

1.2.4. Error Message ........................................................ 18

1.3. Main Window Form Description ...................................... 20

1.3.1. Menu Bar ............................................................. 20

1.3.2. Tool Bar ............................................................... 21

1.3.3. Property Window Form ............................................. 21

1.3.4. Trace Window Form ............................................... 22

2. CONTROL ................................................................. 23

2.1. Menu Bar Controls ...................................................... 24
2.1.1. File ................................................................. 24
2.1.2. Load ............................................................... 26
2.1.3. Edit ........................................................................ 26
2.1.4. View ................................................................. 27
2.1.5. Utility .............................................................. 28
2.1.6. Setting ............................................................ 38
2.1.7. Windows .......................................................... 45
2.1.8. Help ................................................................. 47

2.2. Trace Window Form Controls ........................................ 48

2.2.1. Convert .......................................................... 48
2.2.2. Display Mode .................................................... 52
2.2.3. Marker ........................................................... 54
2.2.4. View Legend ...................................................... 61
2.2.5. Reset Scale ....................................................... 62
2.2.6. Scale ............................................................... 62
2.2.7. Zoom .............................................................. 65
2.2.8. Limit Line ........................................................ 67
2.2.9. Graph Title ....................................................... 68
2.2.10. Report ........................................................ 70
1

GENERAL OVERVIEW

PC GUI

OPERATING MANUAL
1. **GENERAL OVERVIEW**

1.1. **Software Installation**

The A434L Viewer runs on the Windows OS-based PC.

1.1.1. **System Requirements**

System requirements of A434L_Viewer PC program are as follows:

<table>
<thead>
<tr>
<th>Classification</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows XP SP3 or Windows 7 recommended</td>
</tr>
<tr>
<td>CPU</td>
<td>Processor with 300 MHz or higher, 233 MHz in minimum</td>
</tr>
<tr>
<td></td>
<td>Intel Pentium/Celeron series, AMD K6/Athlon/Duron series or other compatible processors</td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB or higher (64 MB in minimum)</td>
</tr>
<tr>
<td>HDD</td>
<td>1.5 GB (available space)</td>
</tr>
</tbody>
</table>

1.1.2. **Install Process**

As based on the .NET Framework 3.5, you must install .NET Framework 3.5 when installing the A434L PC GUI Program.

※ **Caution. Installation of .NET Framework 3.5 requires Internet connection.**
[Installing A434L_Viewer]

Double-click the Setup.exe icon to start the install program.

[Installation 1] Double-click the Setup icon and the installation program is executed as shown in the above figure.

In the [Installation 1] figure, click the ‘Next’ button to move to the next step.
[Installation 2] Setting the installation path

The [Installation 2] figure shows the installation path of the Setup file. Do not modify the path but click the 'Next' button to move to the next step.
[Installation 3] Before starting installation

Click the ‘Next’ button to start installation.
[Installation 4] Installation in progress
[Installation 5] Completion of A434L_Viewer installation

Installation of A434L_Viewer has completed. Click the ‘Next’ button to exit the installation program.

[Installing DotNetFrameWork 3.5SP1]

In the Window 7 operating system or the higher, DotNetFrameWork 3.5.1 has been installed by default; you can skip the following procedure.

Double-click the dotnetfx35setup.exe icon to execute it.
[Installation 6] Preparing for installation of .NETFrameWork 3.5

[Installation 7] Installation of Microsoft .NET Framework 3.5

Choose ‘I have read and ACCEPT the terms of the License Agreement’ radio button and then click the ‘Install’ button to start installation.
[Installation 8] Microsoft .Net Framework 3.5 Download Complete

Download the .Net Framework3.5 and installation is automatically executed when the download completes.
[Installation 9] Completion of .NET Framework 3.5 installation

When Microsoft .NET Framework 3.5 has been installed, you are prepared to use the A434L_PC.GUI program.

1.2. Running Program

Double-click the A434L Viewer icon on the Desktop and the program will start as shown in [Figure 1].
When executing the program for the first as shown in [Figure 1], you are not connected with A434L. To load the Trace from the equipment, you need to connect to the equipment as follows:

1.2.1. Terminal IP Setting

To run the program, you must connect your PC to the equipment via Ethernet and configure the communication environment between the equipment and the PC.

Press the System key from the Menu keys on the right side of the equipment and the screen will be switched to the System screen as shown in the following figure:
[Figure 2] Network information and Instrument Setting Key on the System screen of the A434L equipment

Choose the ‘Instrument Setting’ button from the menu buttons on the right side of the screen and then move to the submenu.

[Figure 3] System screen of the A434L equipment
From the submenu, choose the ‘LAN’ button and then the ‘IP Address’ button to enter the IP address.

![System settings](image.png)

**[Figure 4] Setting IP, Sub Net Mask and Gateway in the given order**

Set ‘Net Mask’ and ‘Gateway’ in the way same with IP setting.

1.2.2. PC IP Setting

After setting the IP address of the equipment, run the PC program and set the IP address of the equipment on the program.

As shown in the following figure, choose [Setting] - [Host IP] from the Menu of the PC program.
In the following IP setting window, enter the IP address of the equipment, which has been set at 1.2.1, in the ‘Server IP’ field.

[Figure 6] Enter the IP address which has been set in the A434L equipment.
1.2.3. Connect & Disconnect

[Connect]

By completing the process of [Figure 6], you are prepared to connect to the equipment. Click the ‘Connect' button to connect to the equipment.

When you are connected successfully, the status displayed at the right bottom of the screen is changed to ‘Connect’ as shown in the following figure.

![Figure 7] ‘Connect' displayed on the right side of the status bar
[Disconnect]

To disconnect from the equipment, click Setting -> Host IP on the top Menu bar and then click the ‘Disconnect’ button in the IP Setting and Connection window; your PC is disconnected from the equipment and ‘Disconnect’ is displayed at the status bar.

1.2.4. Error Message

Some errors may occur with the following error message window while connecting to the equipment. You can fix the errors as follows:

<table>
<thead>
<tr>
<th>State:</th>
<th>When the IP address has been set correctly or when you have tried to connect to the equipment while the PC cable is not connected to the equipment</th>
</tr>
</thead>
</table>

![Figure 8] Connection Error 1

How to fix: Check the IP setting and cable connection.
<table>
<thead>
<tr>
<th>State:</th>
<th>When the cable has been broken or the equipment has stopped while you are connected to the equipment.</th>
</tr>
</thead>
</table>

**[Figure 9] Connection Error 2**

| How to fix: | Check whether the equipment has stopped or whether the cable has been broken. |
1.3. Main Window Form Description

The main window of A434L PC Program consists of Menu Bar, Tool Bar, Property window form and Trace window form and the features are as follows:

![A434L Program Interface]

[Figure 10] Menu Bar and Tool Bar on the top, Property Window on the left, Trace Window at the center

1.3.1. Menu Bar

The main Menu Bar of A434L PC Program provides various features including connection, configuration, trace load and band & cable edit as follows:
### Table 2] Menu Bar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open, Save as, Export, Print, Exit</td>
</tr>
<tr>
<td>Load</td>
<td>Load Current</td>
</tr>
<tr>
<td>Edit</td>
<td>Trace Copy, Trace Paste</td>
</tr>
<tr>
<td>View</td>
<td>Tool Bar, Status Line, Property Window</td>
</tr>
<tr>
<td>Utility</td>
<td>Band Edit, Cable Edit</td>
</tr>
<tr>
<td>Setting</td>
<td>Host IP, Default Trace Setting, Misc, User Info, Prefix, PostFix</td>
</tr>
<tr>
<td>Windows</td>
<td>Cascade, Tile</td>
</tr>
<tr>
<td>Help</td>
<td>Contents</td>
</tr>
</tbody>
</table>

#### 1.3.2. Tool Bar

The A434L PC Program provides icons for some basic features.

![Tool Bar Icons](image)

From the left side, the icons are Open, Save, Print, Capture and Help.

#### 1.3.3. Property Window Form

The Property window form allows you to select the trace information in the
Trace Window and the contents to be displayed at the bottom of the Trace window. It shows information required for each mode, such as VSWR, DTF and Cable Loss. As shown in Figure 10, check each □ with ✓ (✓) to display the checked items at the bottom of the Trace window form.

When you open several Trace window forms, you can enable the Trace window by selecting the Form in the Type Frame list.

1.3.4. Trace Window Form

The A434L PC Program displays the result of the moment when you have executed Load, not the continuous sweep data. The loaded data supports various modes including VSWR, DTF, Cable Loss, Return Loss and Smith Chart and can be converted to various formats such as VSWR and Return Loss in each mode. In addition, features such as Marker and Limit Line are available.
2

CONTROL

PC GUI

OPERATING MANUAL
2. **CONTROL**

2.1. Menu Bar Controls

This section describes the Menu Bar features of A434.

2.1.1. File

The File menu allows you to save or open the data read from the A434L to CSV or JPEG image. It also provides Print feature to print data as a report format.

![File Menu](image)

**Figure 11** File Menu

**Open**
- Opens the saved Trace CSV file and displays it as Trace window form.
- Only the CSV file which has been saved with the ‘Save As’ feature can be opened.

**Save as**
- Saves the information loaded from the A434L as a CSV file.
- All information displayed on the Property window (Load Date, Trace Point, Span, Start & Stop Frequency, Display Mode, etc.) are saved in the CSV file.
- The file name is “Trace current time.csv.”
Export
- Saves as a CSV or JPEG image.
- Saves only the VSWR, DTF, and Cable Loss Trace values corresponding to the Trace frequency range and mode.
- The file name is “Current current time.csv.”
- To image captures and saves the current screen as a JPEG image file.
- The file name is “Image current time.jpg.”

Print
- Prints the program window.
- The printed screen is as follows:

![Figure 12] Preview Print
2.1.2. Load

The Load menu loads data from the equipment. The Load Current button is enabled only when the connection status is Connect.

![Figure 13] Disabled button (left), Enabled button (right)

2.1.3. Edit

The Edit menu can be used only when the PC has been connected and Trace has been loaded.

![Figure 14] Disabled button (left), Enabled button (right)

**Trace Copy**
- Saves the Trace data of the selected Trace window form in the buffer.

**Trace Paste**
- Copies the Trace data saved with the Trace Copy feature to another Trace window form.
The blue trace in the above figure is the main trace of the activated form. The sky-blue trace is the trace copied and pasted from the trace in the Form 1 with the ‘Trace Copy & Paste’ feature.

2.1.4. View

The View menu allows you to set whether to enable or disable the Tool Bar under the menu bar of A434L PC Program, the Status Line under the program window, and the Property window form. You can set it by using the check box in front of each item.
2.1.5. Utility

The Utility menu allows you to load the Custom Band List and the Cable List of the A434L equipment and to create and save the Custom Band List and the Cable List to the equipment. You can save and load the list to the PC as a text file.

[Band List Edit]

1. **ADD & DEL** ➔ Adds the band information or deletes the selected band.

![Figure 17] Band ADD & DEL of Band Edit

Enter the appropriate information in Band Name, Start Frequency and Stop Frequency and then
click the ‘ADD’ button to add the band to the list at the center.

![Image of Band List Window](image)

**Figure 18** Band added to List

2. Load from device ➔ Loads the Custom Band list from the equipment.
Click the ‘Load from device’ button to list up the items included in the ‘Custom Band List’ of the equipment at the center as shown in the figure.

3. **Save to PC** ➔ Saves the band list displayed in the Band Edit window as a file to the PC.
[Figure 20] Saving items in List to PC as a text file

Click the ‘Save to PC’ button and the following window appears:
[Figure 21] File name: “BandList current time.txt”

As shown in the figure, the file format is txt. File and the default file name is the time when the file has been saved.

4. Load from PC ➔ Loads the Band list file saved in the PC.
Click the ‘Load from PC’ button and the following window appears to select a file as shown below.

<table>
<thead>
<tr>
<th>Band Name</th>
<th>Start Frequency [MHz]</th>
<th>Stop Frequency [MHz]</th>
</tr>
</thead>
<tbody>
<tr>
<td>CELLULAR UP</td>
<td>824</td>
<td>849</td>
</tr>
<tr>
<td>CDMA CHINA UP</td>
<td>872</td>
<td>915</td>
</tr>
<tr>
<td>Blue Tooth US &amp; Europe</td>
<td>2400</td>
<td>2484</td>
</tr>
</tbody>
</table>

[Figure 22] Loading Band List text file saved before
[Figure 23] Band Edit - Load From PC

Select a file and click the ‘Open’ button, and then the file is listed up in the Band Edit window.
5. **Frequency Range** ✶ The band range is 5 MHz~ 4,000 MHz. When the input value exceeds the range, an error message popup appears.
[Figure 25] Band Range: 5 MHz ~ 4000 MHz

[Cable List Edit]

The Cable List Edit features are same with the Band List Edit features. Enter the list information and click the ‘ADD’ button to add the list. To save or load the list, use the Load button and the Save button as shown below.
[Figure 26] Cable Edit Features

The list to be added to the Cable List should be within the following range:
Velocity 0~1, 1 GHz & 2 GHz Range 0~3.

When a list exceeds this range, an error message popup appears.

[Figure 27] Error message displayed when out of the range
2.1.6. Setting

As well as the ‘Host IP’ feature to connect with the A434L, the Setting menu provides the ‘Default Trace Setting’ feature to set the thickness and unit of trace, the ‘Misc’ feature to set the font, the ‘User Info’ feature to enter the user information, and the ‘Prefix/Postfix’ feature to set the prefix and postfix of the Trace form chart. Description on the ‘Host IP’ feature is excluded here as it has been described in Section 1.2.

[Default Trace Setting]

[Figure 28] Tab key on the top of setting window can be used.
The ‘Plot/Limit Line Width’ allows you to set the trace line thickness.

[표 3] Setting Trace line thickness

<table>
<thead>
<tr>
<th>Plot/Limit Line Width</th>
<th>Thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thin (Default)</td>
<td>Thin line (Default)</td>
</tr>
<tr>
<td>Thick</td>
<td>Thick line</td>
</tr>
</tbody>
</table>

[Figure 29] Trace Width Thick
The ‘Measurement Unit’ allows you to select the data unit of the DTF mode.

**[Table 4] Unit conversion**

<table>
<thead>
<tr>
<th>Measurement Unit</th>
<th>In meter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meters(Default)</td>
<td></td>
</tr>
<tr>
<td>Feet</td>
<td>In feet</td>
</tr>
</tbody>
</table>

The ‘Footer’ drop-down box allows you to set the list to be displayed in the Property window when loading the trace. Select the mode from the drop-down box. In the Item List, choose the list to be displayed at the mode.

**[Misc]**

It allows you to change the font of the Trace window.
[Figure 30] Changing Font

[User Info]

It allows you to enter the user name and the company name. The user name and company name entered will be automatically entered in the Report window.
[Figure 31] Automatic Insertion of User Info to Report
[Figure 32] Report window with User Info

[Prefix/Postfix]

It allows you to add a prefix and postfix to the sub title in the Trace window.
[Figure 33] Prefix/Postfix of sub title
[Figure 34] Added Prefix and Postfix (in the red rectangle)

2.1.7. Windows

The Windows tab allows you to change the shape and size of the Trace windows. The following figure shows the setting screen.

[Cascade]
[Figure 35] Cascade

[Tile] - [Vertical]

[Figure 36] [Vertical]
2.1.8. Help
The Contents item in the Help menu displays the program information and the GS Instrument information.

2.2. Trace Window Form Controls

The Trace window displays the trace based on the information received from the A434L equipment. In addition, it allows you to analyze the displayed trace by using various features such as Convert, Limit Line, Marker & Delta Marker and Zoom. Right-click on the Trace window form to view various feature menus.

2.2.1. Convert

The Convert feature converts the mode: VSWR, DTF, Cable Loss and Smith Chart. When executing the Convert feature, the format is not loaded newly but converted from the current format to another format. [VSWR]

![Figure 38] When A434L is VSWR Format
[DTF]

[Figure 40] Converted to DTF Format

[Cable Loss]

[Figure 39] Converted to Cable Loss Format
[Smith Chart]

The Smith Chart window provides additional analytic features. Like the Trace window, right-click on the Smith Chart window and the Smith Marker menu appears as shown in [Figure 43].
[Figure 41] Right-clicking on Smith Chart to display Smith Marker Menu

Click the ‘Smith Marker’ button and the Smith Marker window appears as shown in [Figure 44].

By using the Up/Down button at the Data field to change the data point; values of the selected data point are displayed in the following fields and the red marker moves to the data point on the Smith Chart.
[Figure 42] Smith Marker providing Impedance, VSWR and Return Loss

2.2.2. Display Mode

The Display Mode allows you to convert the mode from VSWR mode or DTF Mode to Return Loss Scale View.
[Figure 43] Display Mode

[Figure 44] [VSWR] - [Return Loss]
2.2.3. Marker

The Marker feature provides a marker to move on the trace: you can read the trace value by moving it,
In addition, the Delta Marker feature allows you to read the difference between the marker and the Delta marker.

[Marker]
[Figure 46] Enabled Marker: Up to 10 markers can be marked and the marker value is displayed on the top of the Trace window
[Selecting and Moving Marker]

![Graph showing VSWR CAA with markers](image)

**[Figure 47] Select a marker and click and drag the X symbol to move**

Click the marker image to select it. Place the mouse pointer on the X symbol at the marker image and then the mouse pointer is changed to the cross (+) symbol.

While the mouse pointer is the cross (+) symbol, click and drag the marker image to move. After moving it, the marker value is updated.

**[Move to Max, Move to Min, Move to Center]**
[Figure 50] Move to Max

The Move to Max feature moves the marker to the maximum value position of the trace.
[Figure 48] Move to Min

The Move to Min feature moves the marker to the minimum value position of the trace.
[Figure 49] Move to Center

The Move to Center feature moves the marker to the center of the span.
[Figure 50] Set Delta

The Set Delta feature allows you to calculate the difference between two positions by using a marker and a Delta marker.

1. Select a marker and then click the Set Delta button on the Marker menu: the Delta marker is displayed on the selected marker position.

2. Drag the Delta marker or the marker with the mouse and move it to calculate the difference between the two positions.

3. While using the Delta Marker feature, the data value displayed on the top of the Trace window is the difference between the two markers.

[Set Frequency]
[Figure 54] Set Frequency

The Set Frequency feature allows you to move to the marker position by entering the frequency value directly.

[Marker All Off]

The Marker All Off feature disables all marker features enabled.

2.2.4. View Legend

The View Legend feature displays each trace on the right top as a legend when several traces are used.
2.2.5. Reset Scale

The Reset Scale feature resets the scale or zoom applied to the screen to the initial status when the Scale feature or the Zoom feature has been used.

2.2.6. Scale

The Scale feature allows you to adjust the scale of the Trace window within the scale range loaded at the initial step.
[Figure 52] Scale in VSWR or DTF Mode

Scale is allowed within the scale range of the Trace window loaded first. When the specified range is exceeded, a warning message is displayed.
[Figure 53] Applying Scale

[Figure 54] Scale at Return Loss or Cable Loss mode

Note that the smallest number indicates the largest value in the Return Loss
mode or the Cable Loss mode.

2.2.7. Zoom

There are two ways to zoom in; one is the Zoom button displayed by right-clicking and selecting the Zoom menu and the other one is to drag to the Trace window directly.

[By Right-clicking]

![Zoom feature by right-clicking](image)

[Figure 55] Zoom feature by right-clicking

Directly drag the part with the mouse to zoom it.
[Figure 60] Zoom in by dragging with mouse

As shown in [Figure 60], drag the desired part with the mouse.
[Figure 61] Zoomed-In with mouse drag

[Zoom Out]

There are two ways to zoom out: one is to click [Zoom] and right-click the [Zoom Out] menu with the mouse and the other one is to click the Zoom Out button in the red circle of the Trace window as shown in [Figure 61].

2.2.8. Limit Line

The A434L PC Program provides the Limit Line feature. When the Limit Line feature is enabled, a red vertical line is displayed on the Trace window to divide the screen in half. The trace in the upper half is colored in red.
[Figure 56] Limit Line

The Limit Line feature allows you to move the line up and down by dragging with the mouse and the color is changed and updated whenever the line is moved.

In addition, the user can view the Limit Line value at the bottom of the Property window form or the Trace window.

2.2.9. Graph Title

The Graph Title allows you to set or change the title and sub title of the chart in the Trace window.

Click the Graph Title button and a window appears as shown in [Figure 63]. The Main Title is to set or change the main title and the Sub Title is to set or
change the sub title.

[Figure 57] Graph Title

Both of the main title and the sub title are set to TEST.
2.2.10. Report

The Report feature displays the report form including the current Trace window image captured and prints the report form as a report.

Right-click and click the Report button to display the report form window as shown below.
The User and Company fields are automatically filled when the information is saved in [Setting] - [User Info]
(see 2.1.6 Setting).
<table>
<thead>
<tr>
<th>Title</th>
<th>Current (VSWR CAA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Tester</td>
</tr>
<tr>
<td>Site Information</td>
<td></td>
</tr>
<tr>
<td>Test Purpose</td>
<td></td>
</tr>
<tr>
<td>Result</td>
<td></td>
</tr>
<tr>
<td>Remark</td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td>GS Instrument</td>
</tr>
</tbody>
</table>

**[Figure 59] Easy creation of report with Report feature**

After completing all fields, click the Print button to print the report window including the trace image as shown below.
[Figure 60] Printing Report with Trace image